COLORADO DATA SHARING NETWORK (CDSN)

A Project of the Colorado Water Quality Monitoring Council
P.O. Box 2058 Ridgway, CO 81432 ¢« 970-626-4045 ¢ cdsn@ColoradoWaterData.org *
www.ColoradoWaterData.org

JANUARY 25, 2015

* S

GETTING STARTED WITH THE CDSN MONITORING LOCATION & EXCEEDANCES GOOGLE-MAP UTILITY

The CDSN Google-Mapper allows a user to see monitoring location metadata quickly when the mouse is rolled-over an Ambient Water Quality Monitoring
System (AWQMS), USGS National Water Information System (NWIS), or EPA National Data Warehouse monitoring location at an appropriate zoom level. A
summary of water quality data results can be viewed or downloaded for AWQMS and EPA monitoring locations from the mapper simply by clicking on the
monitoring location, again at the appropriate zoom level. Clicking on a USGS monitoring location will take you to a USGS data download page where you can
download the USGS water quality results data.

The user can turn on the Exceedance filter and specify a characteristic and a threshold value to the AWQMS monitoring locations (EPA & USGS monitoring
locations will continue to display but do not get filtered by the exceedance function). AWQMS Monitoring locations having "hits" or exceedances will then turn
red. With the Exceedance filter active, only data that exceeds the threshold specified for the characteristics specified will be provided for viewing/download
upon clicking on a "red" AWQMS monitoring location. Again, the exceedance filter only works on AWQMS monitoring locations and for the specific
characteristic.

The CDSN "Google-map" was first deployed in the fall of 2011 and allowed for displaying AWQMS monitoring locations, as well as USGS NWIS/NAWQA
monitoring locations and EPA National Data Warehouse monitoring locations. The ability to view monitoring locations that have data in AWQMS which exceeds
a user specified value for a user specified characteristic (analyte) was added in January 2013.

Anyone can search for monitoring locations, exceedances, and download data from the CDSN Google-Map by simply registering as a user with their email
address, for free at http://www.coloradowaterdata.org/cdsnawgms_cdsn.html. The CDSN Google-map and Exceedance map allow for real-time viewing of
monitoring locations and filtering/viewing/downloading data from CDSN AWQMS. However, monitoring locations must have activity/results data stored in
AWQMS to be visible on the map. Simply having monitoring location meta-data stored in AWQMS without also having sampling activity/results data stored in
AWQMS for the same monitoring location by the same organization, will not make a monitoring location appear on the map.

Monitoring locations from the EPA National Data Warehouse (WQX/STORET) & USGS NWIS database monitoring locations are visible on the CDSN Google-map
once they have been linked to the CDSN map. We update the links approximately annually. So if a new EPA National Data Warehouse or USGS NWIS monitoring
location comes online in their systems in between our updates, it will not be visible until the next update. Once an EPA National Data Warehouse or USGS NWIS
monitoring location is linked to the CDSN Google-map, you will be able to click on a USGS or National Data Warehouse monitoring location to get access via a
table or website links to the real-time sampling activity/results data for these monitoring locations.
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The Google-map requires a sufficient zoom level so that monitoring locations are displayed as "waterdrop" symbols, with different colors used to symbolize the
monitoring locations from the three different databases linked to the map: CDSN AWQMS (blue), USGS NWIS (Yellow), or EPA (Orange).

In June, 2013 we upgraded the exceedance utility of the map, so that you could see both the monitoring locations where there are exceedances at the same
time you could see those that don't exceed your thresholds for your analytes. Also, by streamlining the Monitoring Location map and the Exceedance query
feature into one legend, the user interface of the map changed a bit. Whether you are a veteran or a new CDSN Google-map user, please take a minute to skim
through this updated quick-start guide. The 2015 guide adds more details about generating results tables. The text in bold red highlights a change with the
June 2013-January 2015 version of the map, that veteran users will need to note and get used to.

Please help the CDSN Project Coordinators know how the map is working for you and how we can make improvements. Email your comments to
cdsn@coloradowaterdata.org. As always, our ability to make improvements and fix bugs will depend on funding we have available to pay our programmers.
Please consider a contribution either online or by check to CDSN if you use the Google-Map. You can earmark it for map enhancements if you wish.
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1. Find the Google-map and a printable Quick Start Guide, the Expanded Legend, and helpful hints on the CDSN Google-map webpage:

http://www.coloradowaterdata.org/cdsngooglemap cdsn.html

Default Tab, with Quick Start Expanded Legend Tab, with data summary,

Guide and Map Utility Organization Codes and Names, Links to AWQMS step tutorial is in the Quick Start Guide.

Organizations' websites.

Home | Abojit COEN | Get Involved | Contact | Calendar | SWAPs | Data Calls | Forum
AWQMS.Wigx Portals (Database) | CDSN Google-Mlap | CDSN Web GIS

CDSN Google-Map Utility

Helpful Hints Tab. More detail and step-by-
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2. Click on the map image at www.ColoradoWaterData.org/cdsngooglemap 2013.html to open the Google-map utility. If you are using Internet Explorer 9 or
10 (IE9 or IE10) please consider using Mozilla or Google-Chrome. If you continue with IE9 or IE10, you should refer to the compatibility settings notes here to
correct unexpected results or non-performance: &

& lune 2013 Googl_&map k. Exceedance Utility Instructions

Clicn Map -Imae to Open |

I s

LrrereeTy
T e

[Click on Map Image to Open Application)
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3. If this is your first visit to the CDSN Google-Map and depending on your browser settings, you will need to enter your email address into the login box; after
entering your email address remember to press the LOGIN button with your mouse (for some users, hitting the "return" key won't work). If this is your first time
using that email address it will ask you for some information about yourself. We do not share the information. It is used for grant-required user-tracking
purposes. You will only to fill out the info form once, after that your email address is remembered.

Please enter vour email address. If you have not previously registered with this site, vou will need to provide further information for tracking purposes.

|uqm|:@cnlnradnwaterquality.nrg ®
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4. You are now at the default view of the Google-Map. This utility works best with a faster internet connection. 3G cellphone modems are typically not fast
enough for the Map to be responsive without being frustratingly slow.

Select one or more organizations; monitoring locations Toggle basemaps &
will not be visible until you sufficiently zoom in; watch satellite imagery
Drop-down selections to zoom for this symbol to change to a "waterdrop" as you zoom
into general parts of the state n.
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5. There is an expanded legend tab on our Google-Map web page, to help you decipher the Organization IDs, determine how many monitoring locations and
water quality data results are in AWQMS for each organization, and also to help you find each data organization's web sites, in case you wish to learn more
about them. We manually update the legend periodically as needed. Real-time data can also be accessed by using the public login for the AWQMS database will
have the real-time summary tables.

Home | About CDSN | Get Involved | Contact | Calendar | SWAPs | Data Calls | Forum
AWQMS.wqx Pgrtals (Database) | CDSN Google-Map | CDSN Web GIS

' CDSN Google-Map Utility DONATE

R | CDSN Exceedancelf/Monitoring Location Mapper Application About the Mapper & User Hints

v
AWQMS Organization Codes & Expanded Legend

Google-Map Expanded Legend --

This legend provides the Organization |1D codes, full names of CDSN data partners (those in blue are
linked to their web sites) and a summary of the amount of data by organization contained in AWQMS.

& | Summary last updated 10/11/2014.

Total Total -
: i -REG 85"
CDSN OrglD  — y Organization Name r T‘;'::g::sg Reisrl;llt§ UP\IrB%Ed or NP§™
, _ in AWGMS | AWQMs RAmcipant [
| « | AHRA ARKANSAS HEADWATERS RECREATION AREA ¥2 2 2 0 NPS | »
| ARR ADAMS RIB RANCH i (. o o
ARSG ANIMAS RIVER STAKEHOLDERS GROUP s 142,506 o
(Colorado)
ALAMOSA RIVER WATERSHED FOUNDATION !
; ARWRF {ARWRF) 0 0 0
CITY OF AURORA (Water Utility) - Discharge
AURORA_WOX Permit # CO-0026611 3 17,338 7,301 REG 85
BOXELDER SANITATION DISTRICT - Discharge
| BESD Permit # CO-0020478 3 150 150 REG 85
| BIGDRY BIG DRY CREEK WATERSHED ASSOCIATION 8] 0 0
BARR LAKE MILTON RESERVOIR WATERSHED %
BLMRW ASSOCIATION - 16 | 59,316 0]
BRIGHTON_WQOX ;:)l;;g{?BRIGmON - Discharge Permit # CO- El 1,342 70 REG BS
i BTWTRFRM BIG THOMPSON WATERSHED FORUM (CO) 16 8,281 8]
| COWC COAL CREEK WATERSHED COALITION 133 26,218 o
| (Colorado)
CCWF CLEAR CREEK WATERSHED FOUNDATION 53 10,318 0
COLORADO DEPARTMENT OF
| S TRANSPORTATION & & S
| | COLORADO DEPARTMENT OF PUBLIC
CDPHE;NPSP +HEALTH AND ENVIRONMENT NONPOINT - | 0 o ¢ + NPS
SOURCE PROGRAM
CITY OF GREELEY WATER POLLUTION 3
¢ | CGWPCF CONTROL FACILITY - Discharge Permit # CO- 3 160 160 REG 85
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6. Lets zoom in to the San Juan Basin area, and click on "Select All" so that all possible CDSN organizations' monitoring locations are selected to display. Notice
that at this zoom level we see that the monitoring locations will be "blue dots" and not "waterdrops". That is ok for now to get more of an overview. The map
will not display the monitoring locations until you press the "Apply Criteria to Map" button with your mouse. We apologize for this inconvenience, but it was

necessary for combining the exceedance utility and the general Google-Map into one map.

Colorado Data Sharing Network (CDSN)
Water Quality, Habitat & Environmental Da+s

Apply Criteria to Map

Locations " Filters || Options ]

Jump to the following area:

|San Juan/Dolores Basin V‘

BEUEEEEEEERERERE

CDSN AWQMS Organizations
SEE EXPANDED LEGEND TAB FOR FULL
LEGEND INFO

[v] Selectall

AHRA

ARR

ARSE

ARWRF
AURORA_WOQX
BIGDRY

BLMRW
BRIGHTON_WQX

BETWTRFRM

cooT
CDPHE-NPSP

CITYFTCO_WQX

N

Legend
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7. Here is the view after pressing "Apply Criteria to Map". Now there are blue dots representing AWQMS monitoring locations visible on the map.

rado Data Sharing Network (CDSN)
 Web Map
ater Quality, Habitat & Environmental Data
Apply Criteria to Map |
Locations ” Filters || Options ]
Jump to the following area:
|San Juan/Dolores Basin V|
® CDSN A Organizations
: 'SEE EXPANDED LEGEND TAB FOR ~
LEGEND INFO f

select All

AHRA

ARR

ARSG

ARWRF
AURDRA_WQX
BIGDRY
BLMRW
BRIGHTON_WQX
BTWTRFRM
CCWC

CCWF

cooT

CDPHE-NPSP

BRAENERNRNERRERERER

CITYFTCO_WOX

Legend
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8. Lets zoom in on the Mancos monitoring locations. To zoom in or out we use press the "+" or "-" buttons here:

N N Click on the + button or slider to When the symbols are "waterdrops" we can roll our mouse over a monitoring location
Symbol is now a "waterdrop” at this zoom in. Click on the - button or to pop-up useful metadata, like HUC 8 code, type of monitoring location, sampling
zoom level. slider to zoom out. media, and the owner (this is a RiverWatch monitoring location).

Colorado Data Sharing Network
Interactive Web Map
Water Quality, Habitat & Envi

Apply Criteria to Map |

Locations ]‘ Filters | Optiol

Jump to the following ffea:

‘ San JuanIDolop(s Basin

CDSN AWQMS Organizations ~
SEE EXPANDED LEGEND TAR FOR FULL

LEGEND INFO

RSIRA ) . i F - HUCS: 14080107
L - : Org ID: CORIVWEH_WQX
ARR . _ © | MLID: 2403
g - " MLName: At Russell Broperty
ML Type: Rivar/Stream
ARSG - ’
= L Activity Madia: Water
ARWRF
AURORA_WOX
BIGDRY
BLMRW
BRICHTON_WQX
BTWTRFRM
cowe
CCWF

CooT

CDPHE-NPSP

CITYFTCO_WQX
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9. We can download all of the activities/results, with a subset of metadata for this monitoring location by clicking on it. Click on the monitoring location of
interest to download all of the activities and results with associated metadata. We can select to view/download activity/results data in a html pop-up table
within the web browser, or by downloading/opening file in Excel, by clicking on the options tab. Note: When toggling between the two different table options,
you will need to press the "Apply Criteria to Map" button for the change of table output type to take effect. Let's just view the data in a browser table for

now:

IColorado Data Sharing Network (CDSN) AT 144‘ Tl |
Interactive Web Map AN U
Water Quality, Habitat & Environmental Data

Apply Criteria to Map |

Locations H Filters || Optiuhs |

When chicking on a Sk : /
(®) Show results in my browser

) Show results in Microsaft Excel

Paint to & Monitoring Locstion to ses additional
inform=stion 1D & Info

Click ‘o = Moritoring Location to display avsilable

result dats svailable dats in selectad | 4 HUCS: 14080107
Export Forrmat Pl e $ Org ID: CORIVWCH_WQX
i S MLID: 2403
¥ ML Mame: At Russell Property
Monitoring Locations " ML Type: River/Stream
Mote: Monitoring locations and data from el | Activity Media: Water

CDSHN AWQMS is real-time. Monitoring
locations =re updated annually from the
EPA National Data Warehouse & USGS
(however, result data for these locations
are still real-time].
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10. The Google-map starts with the default Browser table output option pre-selected. You can view this from the Options tab.

Colorado Data Sharing Network (CDSN)
Interactive Web Map
Water Quality, Habitat & Environmental Data

Apply Criteria to Map

Locations | Filters | Options | ]

v,
N e e Kstoey aox s bR b T AT ; ‘ ¢ j
@ Show results in my browser ety A j )y \
. - ] 3
2 -

Show results in Microsoft Excel

Monitoring Locations
Note: Monitoring locations and data from
CDSN AWQMS is real-time. Monitoring
locations are updated annually from the
EPA National Data Warehouse & USGS
(however, result data for these locations
are =till real-tima).

By clicking on a blue AWQMS monitoring location, without having used the Exceedance filter query settings, we will get a table containing all of the
activity/results for this monitoring location currently contained in AWQMS. Note - on some computers/browsers this table might open behind your active
window.

o I Bl e e R P R e e B e e e o e e e I et e
Leasirede Tome | TEE Valee | Usit | Tope | Name Limit Meazure Limsit Unit Limit Trpe e
-108.3583041 [ 1 2403 001K | Semple-Fowtine | 10-14-2008 | 053000 PAL| MST  [Waeer | Ammosia 00| g1 Acroal| Tl | Validaned 0.01|maz1 Mathod Datection Lave]
-108 34530411 2403 001N | Saerpie-Rowsios | 10-14-1006% | 05:30-00 PR AT Water | Chiorids 851 |m=1 Actsal | Towl Vabidased 1| mz1 Mlathod Dataction Lava]
-10% 3683041 1 2403 001N | Semple-Rostins | 10-14-2009 | 063000 BM| MET | Water  |Inorgasic sitrogen (mitrete adeitrite)|  0213|mz1 | Aowsat|Total | Validased 0.02| mg1 Mathod Dietocticn Lavel
-108 36830411 1 1405 001N | Samepla-Rovstine | 10-14-200% | 05:30-00 PM|| MST Water | Phosphonm 336| mz1 Acesal | Toeal Validasad 00005 | mz1 Mathod Dasaction Laval
-108 3583041 1 2403 001N | Sarmpla-Rowsins || 10-14-2000 | 05:30:00 PRI MET Tt | Sulfass 1290 mzd Avctzal| Toaad Validassd 05| mzl Mlatticd Danmcticn Lavvsd
-108 35330411 2403 001N | Saerpla-Rowtios | 10-14-2009 | 05:30-00 PM | MET Viater | Totel soupsndad sofidh 1995 | mz1 Actsal | Total Vabdated 4| mz1 Mathod Dadaction Lave]
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11. Let's switch to the "Excel" output option. We must select the "Excel" option by pressing the radio button next to the option from the Options tab

this toggle to take effect we must next press the "Apply Criteria to Map" button.

IColorado Data Sharing Network (CDS
Interactive Web Map
Water Quality, Habitat & Environ I Data

= | $
s ’ ‘ ¥
Apply Criteria to Map (4 f
. el ot A l.:illt&rsl_:i .D_pi:.igs i - [ﬁ} /
£ 4

‘When clicking o monitoring location:

ow resutts in my browser

a Show results in Microsoft Excel
e
| -
Point to = Manitoring Locstion to s=e additional —
information I & Info et
I o . : : o 180
Click on a Maonitoring Location to display available i G

result data available data in selected

Export Formst

Monitoring Locations
MNote: Monitering locations and data from
CDSN AWQMS is real-time. Monitoring
locations are updated annually from the
EPA Mational Data Warehouse & USGS
(howewver, result data for these locations
are still real-time].

LEPH

. Then for

Now when we press on the monitoring location of interest to generate an output table, depending on our individual browser settings we get either a prompt or
a download notification such as the open or save message box below (note the file extension is actually ".aspx" not ".xls which is a true Excel file):
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- -
Opening MapResults.aspx F u

You have chozen to ope/
@ MapResults.aspx

which is: Microsoft Office Excel 97-2003 Worksheet (10.0 KB)
from: http://maps.goldsystems.com

What should Firefox do with this file?

[ Microsoft Office Excel (default) =

(1 SaveFile

7] Do this automatically for files like this from now on.

(o]
-~
&
S
n
g

If you choose "Open with" you will probably get a message like this from Excel:

Fa) The file you are trying to open, 'MapResults.aspx.xls', is in & different format than spedfied by the file extension. Verify that the file is not corrupted and is from & trusted source before
L& opening the file. Do you want to open the file now?

Microsoft Office Excel

[ vs | [0 | [ Hen |

Press "Yes" and the file will open. Now you can save it as a true Excel (.xls) file if desired.

| Home | Insert Page Layout Farmulas Data Review View Add-Ins

@ - o x
ey ; i ) -
Flud it Calibri S Wrap Text General v o ﬁ Normal Bad Good ) l;_l'_‘—l- i 2 Autosun, %_Lr % |
“—' 54 copy — = 5 - : . &] il -
Paste Bz u- ElMergeaicenter - | (8 ~ % 1 |[%8 3%]|| Conditional Format | Neutral _ || Insert Delete Format Sort & Find & |
- J Format Painter — ~'|| Formatting ~ as Table % - A b 2 Clear - Filter - Select =
Clipboard e Font | Alignment = Number = Styles | Cells il Editing | |
| AL - Q&
= & | B I C I i} s it G ] H I ] J ] K I 1 ] ] ] I ] [u] ]
a1
| Monitoring Monitoring Loc: Monitoring Locatio Monitoring Le Project Acotivity  Activity  Activity Start  Activity Start  Activity Start Time  Aotivity Media Characteristic Nams Result Measure Result Measure Result Value Sai
| LotssionID  Hame Latitude Longitude D D Type Date Time Zone _ Name arantel I ane Value Unit  Type
At Buszell Property 3731530331 -108.3683041 1 2403007 Sample-Foutine 10112003 6:30:00PM MST ‘water Ammonia 0.07 wall Actual Tota
At Buszell Property 37.31590331 -1018. 3683041 1 2403.007 Sample-Foutine  10M14/2003  6:30:00PM MST ‘wlater Chlaride 85.1 mgll Actual Tata
At Fuszell Property 373133033 =106, 3683041 1 2403.007 Sample-Foutine 10142003 6:30:00PM M3T wlater Inorganic nitrogen (nitrate and nitive] 0.213 mgll Actual Tota
At Buszell Property 37.31530331 -108. 3683041 1 2403007 Sample-Faoutine  10M14/2003  6:30:00PM MST ‘water Phaspharus 5.36 mall Actual Tata
At Buszell Praperty 37.31530331 -108.3683041 1 2403.007 Sample-Faoutine  1014/2003  6:30:00PM MST ‘water Sulfate 1230 mall Actual Tata
At Fuszell Property 3731330331 =106, 3683041 1 2403.007 Sample-Floutine 10142003 6:30:00PM MIT ‘wlater Total suzpended solids 253.8 mall Actual Tota
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Note: In some browsers, a download file may be automatically generated. You can find it on the bottom left of your browser window, or if using Windows, in
your Downloads folder on your hard drive. When opening the file from your hard drive, we recommend opening Excel first, then navigating to the file (make sure
you are looking for "All Files" instead of just Excel files, since this is an .aspx file) and then opening the file from within the File>Open menu in Excel.

Now, all tables generated in the Google-map will be these quasi-Excel files until you toggle back to the "Show Results in My Browser" button on the Options tab
and press "Apply Criteria to Map" again.

Colorado Data Sharing Network (CDSN)
Interactive Web Map
Water Quality, Habitat & Environmental Det3

Apply Criteria to Map

| Locations | Filiers | Options |
When clicking on a monitoring location: T 0y
Q) Show resufts in my browser - i - - % T B
. I .
Show results in Microsoft Excel o’ . X

Point to & Monitoring Location to see sdditional —_— . \ l \n
infarmation ID & Info

Click on = Manitorin,

result data

Export Format

Monitoring Locations

Note: Monitoring locations and data from
CDSN AWQMS is real-time. Monitoring
locations are updated annually from the
EPA National Dats Warehouse & USGS
(however, result data for these locations
are still real-time).
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12. Some monitoring locations will have results from one or more projects of a particular organization. For example, LEWWTP_WQX's monitoring location has

activity/results data from sampling activities at this location associated with LEWWTP's "SP CURE" Project and "WQCD_REGS85" Project.

Colorado Data Sharing Network (CDSN)
Interactive Web Map
'ater Quality, Habitat & Environmental Data
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When we click on the BEAR CR Monitoring Location, we get a results table that has one row for each result for each project. So a single result that is associated
with both LEWWTP_WQX projects, will appear on two different rows in the Google-map output table (this does not happen when you download data via
Standard Export file within AWQMS):

Results - Google Chrome / [E=IERC
[3 maps.goldsystems.com/MapResults.asgh?uid=1036558&type=NoFilter&excel=false&characteristics= &comparison= = &criteriaValue=&startDate= &startEndDate= Q
/
nitoring . . - Activity | Activity A;::itty Activity - Result | Result
ocation Project ID Activity ID Activity Type L . Media Characteristic Name Measure| Measure
== Start Date | Start Time | Time Name Value Unit
Zone
5.032983|SP CURE éC010213_9:30FIELD Field Msr/Obs  |01-02-2013 (09:30:00 AM |MST Water  |Conductivity 1340 {uS/em
SP CURE / BC010213 9:30FIELD Field Msr/Obs  |01-02-2013 (09:30:00 AM |MST Water |pH 7.54|None
SP CURE BC010213 9. 30FTELLD L R I b B B s 0.3|deg C
WQCD_REGS5|BC010213_9:30LAB Sample-Routine |01-02-2013 [09:30:00 AM [MST Water |Arsenic 0.57 jug/ ~
CURE BC010213 9:30LAB Sample-Routine |01-02-2013 [09:30:00 AM |MST  |Water |Arsenic 0.57 {yg/l "]
SP CURE BCOIOWW-KUULHLC T TS O O i S T e DTy T - 0fug/1
WQCD REGS5|BC010213_9:30LAB Sample-Routine |01-02-2013 [09:30:00 AM|MST  |Water |Beryllium 0fug/1
SP CURE BC010213 9:30LAB Sample-Routine |01-02-2013 [09:30:00 AM [MST  |Water |Cadmiwm 0fug/1
WQCD REGS5|BC010213_9:30LAB Sample-Routine |01-02-2013 [09:30:00 AM |[MST  |Water |Cadmiwm 0fug/1
SP CURE BC010213 9:30LAB Sample-Routine |01-02-2013 [09:30:00 AM |MST  |Water |Calcium 20000 ug/1
WQCD REGS5|BC010213_9:30LAB Sample-Routine |01-02-2013 [09:30:00 AM |MST  |Water |Calcium 20000 ug/1
SP CURE BC010213 9:30LAB Sample-Routine |01-02-2013 [09:30:00 AM [MST  |Water |Chemical oxygen demand 10 |mg/l
WQCD REGS5|BC010213_9:30LAB Sample-Routine |01-02-2013 [09:30:00 AM |MST  |Water |Chemical oxygen demand 10 |mg/l
SP CURE BC010213 9:30LAB Sample-Routine |01-02-2013 [09:30:00 AM [MST  |Water |Chloride 122 |mg/l
WQCD_REGS5|BC010213_9:30LAB Sample-Routine |01-02-2013 {09:30:00 AM [MST Water |Chloride 122|mg/l
SP CURE BC010213 9:30LAB Sample-Routine |01-02-2013 |09:30:00 AM [ MST  |Water |Chromium 1 ug/
TITWTY MIT A0 IThrnina1a aanT AT o 1. mn__u' _dnt oA antalan sn i aarly rom TET_i_ Faas) 1 " v
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13. We can see what USGS and EPA monitoring locations exist in this area by scrolling down in the legend and turning those monitoring location check boxes on
AND pressing the "Apply Criteria to Map" button again:

Legend
EPA monitoring locations will appear as a yellow waterdrop at this zoom level; we will have to zoom scroller

in more to see the USGS monitoring locations as orange waterdrops. After turning these on, you
must press the "Apply Criteria to Map" button again.

Colorado Data Sharing Network (CDSN) ¥ ’ o i1 J ' 17 i - - / = - — ——w
Soaracove e i o _ - | T VL. T [hep] saa]
Water Quality, Habitat & Environmental Data 1 - :

Apply Criteria to Map |

Lacations | Filters | Options |

Jump to the following area:

|San Juan/Dolores Basin /(/|

MEEdEERERERE

[monitoring
locations
updated
02/08/2013)
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14. We can roll our mouse over the USGS and EPA monitoring locations to get similar metadata pop-up boxes.

Colorado Data Sharing Network (CDSN)
Interactive Web Map
Water Quality, Habitat & Environmental Data

Apply Crteria to Map |

Locations |I Filters | Options |

Jump to the following area:

|San Juan/Dolores Basin '

&

M E KR E R EE

RGHRP

SACWSD_WQX

SDISA

STANDLEY

STF

swac

THORNTON_WQX

WRFOBLM

EPA National Data Warehouse
(WQX/STORET)
(monitaring

locations

updated
02/06/2013)

21COL001

USGS
NWIS/NAWQA
(maonitoring
locations
updated
02/08/2013)

UsSGS

Legend

S ab peoy ]

= .
£ )
2.
e
I - | 45
Enchanted | _ = TP )
Mesa-——T— T MANCOS -
Riverside Ave bis@c‘[ Fa >
High School The Church of

_ifi Jesus Christ of

Latter-day Saints . .~
&
. 4') bl

e A

HUCS: 14080107
Org ID: USGS

ML ID: 372113108154001

ML Name: MANCOS RIVER BELOW EAST AND WEST FORKS
ML Type: Rivar/Stresm

52 py 92

B O Bl G 7

> Map data 82013 Google - Terms gﬁ” L@' Report 3 map error i

e 8 |

H100% v
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15. Generating a results output table for an EPA National Data Warehouse (yellow water drop) monitoring location:

e Edit View Hisiory Bolamarks’ Took Help ] TR e e ]

Coloratlo Data Sharing Networ., % | Interactive Map of Colorado x\+

€ & mapsgoldsystems.com C || Q Search B & A& =
|8 Most Visited { | Getting Started |/ Latest Headllines 2 Login to Solar Powere... | anza

EPSON E-WebPrint - | &9 Print [F2 Clip || Enable Flash printing

olorado Data Sharing Network (CDSN) RN f | _——) } Map | Satelite .
nteractive Web ~ ’ = @ B
ater Quality, Habitat & Environmental Data e > / ) (3] 6
P S TN ,
Apply Criteria to Map > {

¢
7 Tl < » \ / 1 A | {

Locations | Filters | Options | - aﬂz.@ / ; ;4 T A

R — . N 5V/ : _ ’

San Juan/Dolores Basin - i ”_, U

SMWC

STANDLEY

STF

swQc
S5D

THORNTON_WQX
TRILWWTF

TWWWTF

UMCRWWTF

uwp

WILLOWCREEK

WWSD

h
-
-
LEPY
\

WMHMD

WRFOBLM

OEOE00O00EOEEE CRENE

o EPA National Data Warehouse
(WQX/STORET)

(monitoring locations updated

02/06/2013)
[ 21coieer

m

& USGS NWIS/NAWQA
(monitoring locations updated
02/08/2013)

uscs (!

< ‘ Rd4g
‘\;a !l‘:

L
28210

Legend

* | ocations are not displayed at this zoom level

@ Locations are displayed, but not clickable, at this

@ Locations can be clicked to view available data

- - -
& ’ ) By o 4
Map data 82015 Google | 500m l——— 1 | TemsofUs= | Reportamap ero

- * —

We can click on an EPA National Data Warehouse (WQX/STORET) monitoring location, just like a blue AWQMS monitoring location. If we have the browser table
option selected we will get a pop-up table like this:
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@ STORET/WQX Data Warehouse Results - Mozilla Firefox _i “- [EEREERT
- - .

File Edit View History Bookmarks Teools Help

@ maps.goldsystems.com/QueryResults.aspriorgld=21COL001 Astationld=9718&isForExcel=false
Organization: 21COL001 -
itori itori Proiect ivi Result | Result Result
Location | Location "JJ Activity ID | Media Characteristic Name Measure|Measure Fraction |Detectection/Qua
ID Name Value Units Limit Measu
MANCOS R ' -
Field i e.nn [Alkalinity, Total (total
9718 QDWEBER SWMN ||20004832-F  ||Water Msr/Obs 2000-10-25|{14:45:00 hydroxids-+carbonate- bicarbonats) 142000 ugfl Actual
MANCOS R Alkalinity, Total (total
9718 @ WEBER ||SWMM ||2004003764-L Water |(Sample |[2004-08-26/|09:25:00 hvdroxide ' 280000 ugfl Actual Total
RO ydroxide+carbonate+bicarbonate)
MANCOS R. Alkalinity, Total (total
9718 @ WEBER ||SWMM |2004003764-L |Water |(Sample |[2004-08-26/|09:25:00 h . ' 250000 ug/l Actual Total
R0 ydroxide+carbonate+bicarbonate)
MANCOS R. Alkalinity, Total (total
9718 @ WEBER ||SWMM ||2004004937-L |Water |(Sample |[2004-11-16/[10:40:00 h . . 150000 ug/l Actual Total
RD. ydroxide+carbonate+bicarbonate)
MANCOS R. Alkalinity, Total (total
9718 @ WEBER ||SWMM |2005000651-L|Water ||Sample |[2005-02-16({11:55:00 h . . 170000 ug/l Actual Total
RD. ydroxide+carbonate+bicarbonate)
2005002015-L
MANCOS R. -
WCustody_ID: na.nn |Alkalinity, Total (total
9718 @ WEBER ||SWMN 050595- Water ||Sample |[2005-05-25|(11:28:00 hydroxids-+carbonate-bicarbonats) 54000 ug/l Actual Total
RO.
JMD-005
2005003961-L
MANCOS R. -
WCustody_ID: e nn.nn |Alkalinity, Total (total
9718 @ WEBER ||SWNMN 05.08-09- Water ||Sample |[2005-08-09|{11:22:00 hydroxide+carbonate-bicarbonate) 180000 ug/l Actual Total
RD.
JPV-001
2005005744-L
MANCOS R .
WCustody_ID: o 4 nn [Alkalinity, Total (total
9718 @ WEBER ||SWMN 05-11-15- Water ||Sample |[2005-11-15/{15:04:00 hydroxide+carbonate-+bicarbonate) 150000 ug/l Actual Total
RD. IMN-n07 i
. Il | 3

e —— B TR

If we have the "Excel" option selected we will get to see many of the same message boxes as if we were clicking on a blue AWQMS monitoring location. First we
get the Open/Save box:
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Cpening QueryResults.aspx

You have chosen to open:
5 QueryResults.aspx

which is: Microsoft Office Excel 97-2003 Worksheet (74.7 KB)
from: http://maps.goldsystems.com

‘What should Firefox do with this file?

Microsoft Office Excel (default)

() Save File

i 7] Do this automatically for files like this from now on.

OK Cancel

Choosing to open with MS Excel, we next get

-

Microsoft Office Excel

S

The file you are trying to open, 'QueryResulis.aspx-1.xds', is in a different format than spedfied by the file extension, Verify that the file is not corrupted and i from a trusted source
l A before opening the file, Do you want to open the file now?

/LYESI[N:: ]lHeIp

(Select "Yes") and after pressing "Yes", in my version of Excel at least, | get one more message box:

Problems During Load

12 o)

Problems came up in the following areas during load:

-

oK ]’ Cancel l

Click OK above and the results file of the data available for this monitoring location stored within the National Data Warehouse will open:
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E;\m “—"_ QueryRsuhs.asp;(-I - Microsoft Excel ' “ mlr@u g
Ly = p=

4 4 » | QueryResults.aspx-1 - ¥J

il |

Ready

[0 e Cie0

Home Insert Page Layout Formulas Data Review WView Add-Ins @ - T X
._..j '* ik Calibri 1 - |[AN AT =[®-| | Siwapred General - ﬁj % Normal Bad Good _E Autostm %? [ﬁ
5 SRR = T =0 .00 Condi;onal Format = Neutral | C s Insert Delete F‘ormat E G Sort & Find &
Paste F ot banct (B B ||| A EqMerge & center - | | $ - % o || %8 5% A atiAE T L b eutia = = . o 2 Clear = Filter~ Setpet=
Clipboard iF] Fant iF] Alignment iF] MNumber {F] Styles Cells Editing
Al - £ |
| 4] A B c D E F G H [ J K £
o ]
2
3 |Organization: 21COL001
a Monitoring Location ID | Monitoring Location Name | Project ID Activity ID Activity Media Name | Activity Type |Activity Start Date | Activity Start Time Characteristic Name Result Measure Value | Result Measure Unit
Alkalinity, Total (total
5 9718|MANCOS R. @ WEBER RD.  |SWMN 20004832-F Water Field Msr/Obs 10/25/2000 14:45:00|hydroxide+carbonate+bicarbonate) 142000|ugfl
Alkalinity, Total (total
6 9718|MANCOS R. @ WEBER RD.  |SWMN 2004003764-L Water Sample 8/26/2004 9:25:00|hydroxide+carbonate+bicarbonate) 280000/ ug/l
Alkalinity, Total [total
7 9718|MANCOS R. @ WEBER RD.  |SWMN 2004003764-L Water Sample 8/26/2004 9:25:00|hydroxide+carbonate+bicarbonate) 280000 | ugfl
Alkalinity, Total (total
3 9718|MANCOS R. @ WEBER RD.  |SWMN 20040048357-L Water Sample 11/16/2004 10:40:00 |hydroxide+carbonate+bicarbonate) 150000 ug/l
Alkalinity, Total (total
4] 9718|MANCOS R. @ WEBER RD.  |SWMN 2005000651-L Water sample 2/16/2005 11:55:00 |hydroxide+carbonate+bicarbonate) 170000|ug/l
2005002015-L \\Custody_ID: 050525-1MD- Alkalinity, Total (total
10 9718|MANCOS R. @ WEBER RD.  |SWMN  |005 Water Sample 5/25/2005 11:28:00|hydroxide+carbonate+bicarbonate) 54000|ug/!
2005003961-L \\Custody_ID: 05-08-08-1PV- Alkalinity, Total (total
11 9718|MANCOS R. @ WEBER RD.  |SWMN 001 Water Sample 8/9/2005 11:22:00|hydroxide+carbonate+bicarbonate) 180000 | ug/l
2005005744-L \\Custody_ID: 05-11-15-IMD- Alkalinity, Total (total
12 9718|MANCOS R. @ WEBER RD.  |SWMN 007 Water Sample 11/15/2005 15:04:00 | hydroxide+carbonate+bicarbonate) 150000 | ug/l
20060007 18-L \\Custody_ID: 06-03-07-R5G- Alkalinity, Total (total
13 9718|MANCOS R. @ WEBER RD.  |SWMN 001 Water Sample 3/7/2006 9:30:00 | hydroxide+carbonate+bicarbonate) 160000 | ug/l
2006001722-L \\Custody_ID: 06-05-23-HPV- Alkalinity, Total (total
14 9718|MANCOS R. @ WEBER RD.  |SWMN 0os Water Sample 5/23/2006 17:51:00|hydroxide+carbonate+bicarbonate) 86000|ug/l
15 9718|MANCOS R. @ WEBER RD.  [SWMN 20004832-L Water Sample 10/25/2000 14:45:00|Aluminum
16 9718|MANCOS R. @ WEBER RD.  |SWMN  |2004003764-L Water sample 8/26/2004 9:25:00|Aluminum
17 9718|MANCOS R. @ WEBERRD. [SWMN  |2004003764-L Water sample 8/26/2004 9:25:00 | Aluminum
i8 9718(MANCOS R. @ WEBER RD.  [SWMN 2004004937-L Water Sample 11/16/2004 10:40:00|Aluminum
19 9718|MANCOS R. @ WEBER RD.  |SWMN 2005000651-L Water Sample 2/16/2005 11:55:00(Aluminum
2005002015-L \\Custody_ID: 050525-IMD-
20 9718|MANCOS R @ WEBER RO [SWMN 005 Water Sample 5/25/2005 11:28:00 (Aluminum
2005003961-L \\Custody_ID: 05-08-09-1PV-
i § 9718(MANCOS R. @ WEBER RD.  [SWMN 001 Water Sample 2/9/2005 11:22:00|Aluminum
2005005744-L \\Custody_ID: 05-11-15-JMD-
22 9718(MANCOS R. @ WEBER RD.  [SWMN 007 Water Sample 11/15/2005 15:04:00|Aluminum
20060007 18-L \\Custody_ID: 06-03-07-R5G-
23 9718(MANCOS R. @ WEBER RD.  [SWMN 001 Water Sample 3/7/2006 9:30:00|Aluminum
2006001722-L \\Custody_ID: 06-05-23-HPV-
24 9718|MANCOS R. @ WEBER RD.  |SWMN 0os Water Sample 5/23/2006 17:51:00(Aluminum
25 9718 |MANCOS R. @ WEBER RD.  [SWMN 20004832-L Water Sample 10/25/2000 14:45:00(Arsenic
26 9718|MANCOS R. @ WEBER RD.  |SWMN  |2004003764-L Water Sample 8/26/2004 9:25:00|Arsenic
L 9718|MANCOS R. @ WEBER RD.  [SWMN 2004003764-L Water Sample 8/26/2004 9:25:00|Arsenic
28 9718 (MANCOS R. @ WEBER RD.  [SWMN 2004004937-L Water Sample 11/16/2004 10:40:00 (Arsenic
29 9718|MANCOS R. @ WEBER RD.  |SWMN 20004832-L Water Sample 10/25/2000 14:45:00(Cadmium

3 -
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16. Generating a results output table for a USGS NWIS (orange water drop) monitoring location:

File Edit View Hist

Bookmarks Tools Help

nteractive Map of Colorado % | -

& | @ mapsgoldsystems.com @ || Q search wBa ¥+ &=

[B) Most Visited [} Getting Started |5/ Latest Headlines 2 Login to Solar Powere... | anza
EPSON E-WebPrint - | ¢ Print [ Clip [ Enable Flazh printing

|Colorado Data Sharing Network (CDSN) Li# (._ -
| Interactive Web Map ~
(Water Quality, Habitat & Environmental Data \

| vy rrerato g |

Locations | Filters | Options |

Jump to the following area:

San Juan/Dolores Basin

HUCS: 14080107
Org ID:USGS
ML ID: 571640108210807
ML Name: FOND NEAR 35 AND & ROADS (COLBERT) | )
| MLType s =
— =

A\ Gs_:/' =
R S -

WWSD

P

WMHMD

OJEEEO0O000O0OEEEC

WRFOBLM

o EDA National Data Warehouse
(WOQX/STORET)
(monitoring locations updated
02/06/2013)

21COL0D1
& USES NWIS/NAWQA
(monitoring lacatians updated

02/08/2013)

@ uscs

Legend

% Locations are not displayed at this zoom level

# Locations are displayed, but not clickable, at this

@) vocations contie chhei to vien a -

Clicking a USGS monitorning location water drop will not open a results table directly.
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Upon clicking this type of monitoring location when sufficiently zoomed in, a new window will open to the url of that monitoring location's USGS web page
(below). You can choose from a variety of USGS output options from the USGS page./

- -
@ USGS 371840108210901 POND NEAR 38 AND G ROADS (COLBERT) Water Quality Data - Mozilla Firefox
File Edit View History Bookmarks Tools Help

‘:Elg

f——

¥ nwis.waterdata.usgs.gov/usa/nwis/qwdata/Tsite_no=371840108210901 Bagenc

ZUSGS 1%

F ..
r & changing world

National Water Informatlon Sy5tem: Web Interface

USGS Water Resources

© Click to hide News Bulletins

« January 5, 2015 - The system upgrade is completed. Please refer to News
» Try our new Maobile-friendly water data site from your mobile device!
« Full News B

Water Quality Samples for the Nation

Additional precautions are here.

v_cd=USG58inventory_output=08irdb_inventory

To view additional data-quality attributes, output the results using these options: one result per row, exppnded attributes.

_output=faluedTZoutput=08pm_cd_compare=Greater than&radio_parm_cds=all_parm_cd:

USGS Home
Contact USGS
Search USGS

Data Category:
Water Quality

Geographic Ares:

United States

-

m

USGS 371840108210901 POND NEAR 38 AND G ROADS (COLBERT)
Available data for this site WU CReN8 = sTil- ] sampI¢5

T D

Montezuma County, Colorado
Hydrologic Unit Code 14080107

v

Output formats

Latitude 37°18'40", Longitude 108°21'09" NAD27

Parameter Group Period of Record table

Gage datum 6,650 feet above NGWD29

Inventory of available water-guality data for printing

Inventory of water-guality data with retrieval

Tab-separated data, one result per row

Tab-separated data one sample per row with remark codes combined with values

Tzb-separated data one sample per row with tab-delimiter for remark codes

Reselect output format

(I "_[
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17. Let's use the Exceedance feature. It will only work for the CDSN AWQMS monitoring locations (see note on screenshot below), because it is feeding our
exceedance query real-time from the CDSN AWQMS database. First, | have selected organizations ARSG and CORIVWCH_WQX as the displayed monitoring
locations (Animas River Stakeholders Group and Colorado RiverWatch). | hit the "Apply Criteria to Map" button again. | zoomed into Silverton by holding my

mouse down on the map and dragging it into the centered position | wanted. | also clicked on the Filters tab. Upon clicking on the Filters tab, you may have to
wait several seconds to a couple minutes to let the Exceedance Criteria selection values appear.

The criteria boxes will look like this while the criteria selectors are fully loading

File Edit View History Bookmarks Tools HEEP‘E i

Interactive Map of Colorado x

& @ maps.goldsystems.com

'C'HQS&GKPJ ‘ﬂ B 4+ ﬁ|E
18 Most Visited [ Getting Started 5 Latest Headlines = Login to Solar Powere... 7 anza
EPSON E-WebPrint - Q Print [5G Clip Enable Flash printing
[Colorado Data Sharing Network (CDSN) '
|[Interactive Web Map
ater Quality, Habitat & Environmental Data

Locations |[ Filters h Options |

X
* NOTE: These filters do not apply to the Y£Gs or
Cnlnradoﬂizbalgmu:y

-

Value above/below*:
8 Above
' Below

Activity Date: (mm-dd-yyyy)
Between

And
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| selected "Zinc ug/l Total" as my characteristic (analyte) of interest, by clicking on it after scrolling down the list with the scroller; and | chose a threshold value
of 50 and entered it. This means the map will display the exceedance locations where total zinc has been measured at greater than 50 ug/l. A date range can be
specified if desired, but can be left blank if you don't wish to use it or if you don't know the full date range of the monitoring location's data.

Colorado Data Sharing Network (!
Interactive Web Map
Water Quality, Habitat & Environmental

Apply Criteriato Map |

Locations ”’ Filters " Options |

* MOTE: These filters do not apply
Colarado State Agency.

Zinc ug/l Total Recaoverab...
Zinc mg/l Total

Zinc mg/l Acid Soluble
Zinc mg/l

Zinc ug/l Dissolved

Zinc mg/l Dissolved
Zinc | Pot. Dissolved

e USGS or

q
Zinc ug/ Filterable
Zinc mglkg Total

Value above/below*:
® Above
CiBelow
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18. After pressing "Apply Criteria to Map" | get these results displayed where those monitoring locations in exceedance of the criteria are now in red. Note -
Monitoring locations that have results for the characteristic/units/sample fraction specified not exceeding the threshold, will still display as blue waterdrops:

Apply Criteria to Map

Locations || Filters || Options |

* NOTE: These filters do not apply to the USGS or
Colorado State Agency.

Zinc ug/l Total Recoverab...

Zinc mg/l Total ~

Zinc mg/l Acid Soluble

Zinc mg/|

Zinc ug/| Dissolved

Zinc mg/l Dissolved

Zinc ﬁ\ Pot. Dissolved
g

Zinc ug/| Filterable (V]
Zinc mg/kg Total

Value above/below*:
® Above
) Below

Activity Date: (mm-dd-yyyy)
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19. Now I can roll my mouse over the monitoring locations to see the pop-up metadata again. | can view/download the data for Zinc ug/I Total for any
monitoring location (exceeding the 50 ug/I specified threshold or not) by clicking on the monitoring location. | will only be able to see or download the Zinc
ug/l Total results data since the exceedance filter is on. The map will only let you view/download results data for one monitoring location at a time. If you
would like to download a batch of data for multiple monitoring locations at once, we recommend using the public login for our AWQMS database and
generating a Standard Export file. (You will find an AWQMS data download guide on our AWQMS page, www.coloradowaterdata.org/cdsnawqgms_cdsn.html

Colorado Data Sharing Network (CDSN)
Interactive Web Map
Water Quality, Habitat & Environmental Data

Apply Criteria to Map |

Locatichs || Filters | Options |

Jump to the following area:

| San Juan/Daolores Basin

BLMRW

BRIGHTON_WQX

CDPHE-NPSP
CITYFTCO_WOX

COLO319

CORIVWCH_WOX HUCS: 14080104

v ' o iy Z Org ID: CORIVWCH_WQX
CSU_SEFE AEE == MLID: 3541
Tt ¢ ML Mame: Abowve Mineral Cr
cuss x ML Type: River/Stream
- Activity Media: Water

CWSD_WQX
DDEH_WQX
DRMS
ERWC

GCWIN

0 5 0 ) 13
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20. Below, my exceedance table is only showing the total zinc ug/l results EXCEEDING my threshold. There may be other Zinc ug/| Total results for this
monitoring location in AWQMS. But if | click on a red monitoring location with the Exceedance filter on, | will only get a table with the results EXCEEDING the
value | entered in my query. Again, if | click on a red monitoring location with an exceedance filter in effect, | will not be downloading all of the activities/results
for this monitoring location that exists in AWQMS as we did in steps 9-11 -- just the data for the characteristic, units and sample fraction selected.

I S e — Activity . . I
IGIRBIORE | et ||| R | VIOSNOMRE ||l . e R e et R S U S
Location Location Name Location Location D Activity ID | Activity Type Start Date  Start Time = Time Media Name Measure Measure
D Latitude Longitude Zone Name Value Unit
I 3541 Above Mineral Cr |37 80070441 |-107 6673745 |1 3541 001M | Sample-Routine | 09-09-1997 | 12:00-00 AM |MST  |Water | Zinc 487 |ugl
! 3541 Above Mineral Cr |37 80070441 |-107.6673745 |1 3541.001M | Sample-Routine [ 09-09-1997 | 12:00:00 AM | MST  Water |Zinc 451 jugl
I

Similarly, if | click on a blue monitoring location, | will only get the results for zinc, total, ug/l, and not for the results for other characteristics for that monitoring

location.

21. To refresh the map and start fresh from the default view, and to clear the exceedance query filter, | need to press the F5 key on my keyboard (above the

number 4 key usually).
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22. Selecting multiple characteristics/units/sample fractions in one Exceedance query - we can hold down the CTRL key and select multiple characteristics (in
this example, Zinc, ug/l, dissolved and Zinc, ug/|, total) in one query. [Both of our selections are not visible in the menu in the screen shot below, but we do
have BOTH dissolved and total Zinc, ug/l selected]. Note, only those monitoring locations having results for these parameters remain in the view, either as red
(exceeding our threshold of 50) or blue. The others for which there are no zinc, [sample fraction], ug/| results disappear.

[Colorado Data Sharing Network (CDSN)
|interactive web Map
| Water Quality, Habitat & Environmental Data

Apply Criteria to Map
Locations ” Filters | Options |

# NOTE: These filters do not apply to the USGS or
Colorado State Agency.

Zinc mg]l Tatal o
Zinc mg/l Acid Soluble

Zinc ug/l Total Recoverab...

Zinc mg/!

Zinc ppb Total

g
Zinc mg/l Pot Dissolved
Zinc mg/| Dissolved
Zinc mg/kg Total

Zinc ug/l Suspended

Value above/below*:
@ above

Activity Date: (mm-dd-yyyy)
Between

And
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The result table for a "red" monitoring location will contain the results for each of the selected characteristics exceeding the threshold. For example, my query

criteria for Zinc, ug/|, dissolved and Zinc, ug/|, total; exceeding a value of 100. Here is a result table for a "red" monitoring location:

Monitoring| Monitoring |, . | Activity . Activity | Activity A;'::::y ACtVIEY | o racteristic| oSt | Result |Result) Sample | o
Location | Location Activity Type - . Media Measure | Measure | Value | Fraction Dei
Latitude | Longitude D D Start Date | Start Time ';::: Name Name Value Unit Type | Name Status

tCr 37.8159| -107.6618|1 323.001M | Sample-Routine | 07-23-1992 [03:30:00 PM |MST  |Water |Zinc 725 |ugl Actual |Dissolved | Validated
t Cr 37.8159| -107.6618|1 323.001M | Sample-Routine | 07-23-1992 [ 03:30:00 PM |MST Water | Zinc 808 |ugl Actual |Total Validated
tCr 37.8159| -107.6618|1 323.002M | Sample-Routine | 09-20-1992 [ 11:53:00 AM |MST  |Water |Zinc 1070 |ugl Actual |Total Validated
tCr 37.8159| -107.6618|1 323.003M | Sample-Routine | 10-12-1994 [03:50:00 PM |[MST  |Water |Zinc 1077 |ugl Actual |Dissolved | Validated
tCr 37.8159| -107.6618|1 323.003M | Sample-Routine | 10-12-1994 [03:50:00 PM |MST  |Water |Zinc 1082 |ugl Actual |Total Validated
tCr 37.8159| -107.6618|1 323.004M | Sample-Routine | 11-09-1994 (03:46:00 PM |[MST  |Water |Zinc 999 |ug/ Actual |Dissolved | Validated
t Cr 37.8159| -107.6618|1 323.004M | Sample-Routine | 11-09-1994 [03:46:00 PM |MST  |Water | Zinc 1160 |ug Actual |Total Validated
tCr 37.8159| -107.6618|1 323.005M | Sample-Routine | 12-13-1994 (03:00:00 PM |[MST  |Water |Zinc 892 |ugl Actual |Dissolved | Validated
t Cr 37.8159| -107.6618|1 323.005M | Sample-Routine | 12-13-1994 [03:00:00 PM |MST  |Water |Zinc 935 |ugl Actual |Total Validated
tCr 37.8159| -107.6618|1 323.006M | Sample-Routine | 01-18-1995 (03:41:00 PM |MST  |Water |Zinc 910 |ugl Actual |Dissolved | Validated
tCr 37.8159| -107.6618|1 323.006M | Sample-Routine |01-18-1995 (03:41:00 PM |MST Water |Zinc 840 |ugl Actual |Total Validated
t Cr 37.8159| -107.6618|1 323.007M | Sample-Routine | 02-15-1995 [03:50:00 PM |[MST  |Water |Zmnc 116 |ugl Actual |Dissolved | Validated
t Cr 37.8159| -107.6618|1 323.007M | Sample-Routine | 02-15-1995 [03:50:00 PM |[MST  |Water |Zinc 1140 |ug Actual |Total Validated
t Cr 37.8159| -107.6618|1 323 008M | Sample-Routine | 03-01-1995 [03:50:00 PM |[MST  |Water |Zinc 1143 |ugl Actual |Dissolved | Validated
tCr 37.8159| -107.6618|1 323.008M | Sample-Routine | 03-01-1995 [03:50:00 PM |MST  |Water |Zinc 1241 |ugl Actual |Total Validated
t Cr 37.8159| -107.6618|1 323.009M | Sample-Routine | 03-15-1995 [03:50:00 PM |MST  |Water |Zinc 1407 {ugl Actual |Dissolved | Validated
t Cr 37.8159| -107.6618|1 323.009M | Sample-Routine | 03-15-1995 [03:50:00 PM |[MST  |Water | Zinc 1418 |ugl Actual |Total Validated

m| s

E— e R B
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The result for the same query, but for a blue, non-exceeding monitoring location:

|
o |Mouioriag Mosoring || tege | Ay | Aciiy | St A | Choractrae| Ko | Rl |Resu Sample |

ame Latitude | Longitude L St e ';::: Name S Value TUnit Type | Name Lo

i Exp JJ 37.8931| -107.6809]1 9003.001M | Sample-Routine | 03-05-2012 | 12:00:00 AM | MST Water |Zinc 0 |ugl Actual |Dissobved | Validated
i Exp JJ 37.8931| -107.6809]1 9003.001M | Sample-Routine | 03-05-2012 | 12:00:00 AM | MST Water |Zinc 32.1 |ugl Actual |Total Validated
ir Exp 17 37.8931| -107.6809]1 9003 .002M | Sample-Routine | 03-05-2012 | 12:01-:00 AM | MST Water |Zinc 0 |ugl Actual |Dissobved | Validated
ir Exp JJ 37.8931| -107.6809]|1 9003 .002M | Sample-Routine | 03-05-2012 | 12:01-:00 AM | MST Water |Zinc 26.1 |ugl Actual |Total Validated
ar Exp IJ 37.8931| -107.6809]1 9003 .003M | Sample-Routine | 03-05-2012 | 12:02:00 AM |MST Water |Zinc 0 |ugl Actual |Dissobved | Validated
ar Exp IJ 37.8931| -107.6809]1 9003 .003M | Sample-Routine | 03-05-2012 | 12:02:00 AM |MST Water |Zinc 26.1 |ugl Actual |Total Validated
ar Exp I 37.8931| -107.6809]1 9003 004M | Sample-Routine | 03-05-2012 | 12:03:00 AM |MST Water |Zinc 0 |ugl Actual |Dissobved | Validated
ar Exp JJ 37.8931| -107.6809]1 9003.004M | Sample-Routine | 03-05-2012 | 12:03:00 AM |MST Water |Zinc 58.5 |ugl Actual |Total Validated
i Exp 1] 37.8931| -107.6809]1 9003.005M | Sample-Routine | 03-05-2012 | 12:04:00 AM | MST Water |Zmc 0 |ugl Actual |Dissolved | Validated
ar Exp JJ 37.8931| -107.6809]1 9003.005M | Sample-Routine | 03-05-2012 | 12:04:00 AM | MST Water |Zinc 24 6 |ugl Actual |Total Validated
i Exp JJ 37.8931| -107.6809]1 9003.006M | Sample-Routine | 03-05-2012 | 12:05:00 AM | MST Water |Zinc 0ugl Actual |Dissobved | Validated
ar Exp IJ 37.8931| -107.6809]1 9003 006M | Sample-Routine | 03-05-2012 | 12:05:00 AM |MST Water |Zinc 35 |ugl Actual |Total Validated
ir Exp 1 37.8931| -107.6809]1 9003 .007M | Sample-Routine | 03-05-2012 | 12:06:00 AM | MST Water |Zinc 0 |ugl Actual |Dissobved | Validated
ar Exp IJ 37.8931| -107.6809]1 9003 .007M | Sample-Routine | 03-05-2012 | 12:06:00 AM |MST Water |Zinc 9 |ugl Actual |Total Validated
ar Exp I 37.8931| -107.6809]1 9003 .008M | Sample-Routine | 03-05-2012 | 12:07-00 AM |MST Water |Zinc 0 |ugl Actual |Dissobved | Validated
ar Exp I 37.8931| -107.6809]1 9003 .008M | Sample-Routine | 03-05-2012 | 12:07-00 AM | MST Water |Zinc 208 |ugl Actual |Total Validated
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23. Getting the message "no results were found":

The page at maps.goldsystems.com says:

no results were found.,

This message occurs when there are no monitoring locations within your zoomed in view that meet your search criteria. You can zoom out and pan around the
map to see if you will get results at a different map view. Don't forget to press the "Apply Criteria to Map" button again from your new view. It is suggested that
you refer to the Expanded Legend tab to get an idea of the number of monitoring locations and results different data providers have shared in AWQMS, and
their general area of interest.

Last note: The purpose of the Google-map and Exceedance tool is to allow for a quick way to interact with monitoring locations and results geo-spatially. If you
need to make sure you are getting all of the results data for a group of monitoring locations or characteristics, exceedances or non-exceedances, we recommend
you download data via the Standard Export file option directly from the public login to the CDSN AWQMS database (more information at
http://www.coloradowaterdata.org/cdsnawgms _cdsn.html.)

The CDSN Project Coordinators are always interested in your feedback about this and any of our tools. Please email your comments and suggestions to
cdsn@ColoradoWaterData.org. As always, our ability to make improvements will depend on funding we have available to pay our programmers. Please
consider a contribution either online or by check to CDSN. You can earmark it for map enhancements if you wish. If we can help you in any way please don't
hesitate to call us at 970-626-4045 or email us.
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